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This document is based on information available at the time of its publication. While efforts

have been made to ensure the contents of this manual are accurate, the information
contained herein does not purport to cover all specific details or variations in hardware, or
to provide for every possible contingency in connection with installation, operation, or
maintenance. Features may be described herein which are not present in all hardware and
software systems. Precision Valve and Automation, Inc. assumes no obligation of notice to

holders of this document with respect to changes subsequently made.

Precision Valve and Automation, Inc. makes no representation or warranty, expressed,
implied, or statutory with respect to, and assumes no responsibility for the accuracy,
completeness, sufficiency, or usefulness of the information contained herein. No warranties

of merchantability or fitness for purpose shall apply.

This document, including the information contained herein, is the property of
Precision Valve and Automation, Inc. and is considered confidential and proprietary
information. Itis delivered on the express condition that it not be used, disclosed, or
reproduced, in whole or in part, for any reason without prior written consent of
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1. Introduction

Before you operate this system, read the operation and setup manual. This will help you to
become familiar with the product and ensure successful operation.

If any questions or problems arise, contact PVA’'s Technical Support department.

1.1 PVA Contact Information

Main Office PVA
6 Corporate Drive
Halfmoon, NY 12065
Tel +1-518-371-2684
Fax +1-518-371-2688

Website: http://www.pva.net

Email: info@pva.net
Technical Support

Tel +1-844-734-0209

Email: cs@pva.net

1.2 Document History

Revision Revision Date Reason for Changes

REVC April 2021 Maintenance Schedule Added

REVB July 2020 Download Instructions for Inkscape, G-code
REV A May 2020 Initial Release

Note: All photographs and CAD model representations in this document are a
“general representation” of the system and its components. The actual appearance
of the system and its components can differ based upon customer specific
configuration.
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11 Safety

Certain warning symbols are affixed to the machine and correspond to notations in this
manual. Before operating the system, identify these warning labels and read the notices
described below. Not all labels may be used on any specific system.

v

Always wear approved safety glasses when you operate or work near the
workcell.

Before you operate the system, read and understand the manuals provided
with the unit.

Never put hands or tools in areas with this symbol when the machine is in
operation. A dangerous condition may exist.

Read and understand the manuals provided with the unit before any repairs
or maintenance is done. Only a qualified individual should do service.

Use caution when there are pressurized vessels. Find and repair any leaks
immediately. Always wear appropriate safety equipment when you work
with pressurized vessels or vessels that contain chemicals

Shear hazard from moving parts. Avoid contact.

Do not remove protective guarding.

In situations where inattention could cause either personal injury or damage
to equipment, a warning notice is used.
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FE

Do not smoke near the machine. Always have a fire extinguisher available
for emergency use.

Before performing any repairs or maintenance to the system, turn off power
and lock out the power disconnect switch.

Warning notices are used to emphasize that hazardous voltages, current,
temperatures, or other conditions that could cause personal injury exist in
this equipment or may be associated with its use. Only qualified personnel
should enter areas designated with this symbol.

Laser light source present. Do not stare directly into the beam. Do not use in
the presence of highly reflective surfaces

Pinch hazard from moving parts. Avoid contact.

Hot surface. Avoid contact.

Warning, Ultraviolet (UV) light hazard. Do not look directly at the UV light
source.
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1.1 System Description

The Sigma benchtop is a compact three-axis robotic gantry ideal for automating a variety
of dispensing and coating applications. Featuring multiple mounting positions, users can
easily incorporate multiple chemistries or application techniques into their process. With
remote programming capability and image background import, programs can be quickly
uploaded from your desktop utilizing Sigma'’s internal 2.4 GHz Wi-Fi network.

1.2 Personal Protective Equipment

Workcell operation includes air pressure, electrical power, mechanical devices, and the use
of hazardous materials. Only qualified personnel can operate and service workcells.
Operators must use eye protection because material contents are under pressure. Always
wear gloves when handling materials and solvents. Refer to MSDS sheets on the material
that is used for other precautions.

1.3 BestPractices

e Do not wear loose clothes or jewelry when you operate the workcell

e Do not touch the dispense head while it is moving

e Make sure cables and pneumatics hoses are attached and do not cross walkways
¢ Immediately engage the Emergency Stop button if personnel is in danger

e Locate and define all safety labels on and around the workcell before you turn the
machine “On”

e There must be two people during maintenance procedures

e Dispose of all used parts and materials in accordance with local laws and
regulations

e Safety is a joint responsibility between the OEM and the end-user. All precautions
and practices should be in accordance with local regulations.

DO NOT use incompatible tools, remove door interlocks or bypass safety devices,
make custom mechanics or fluid delivery modification, or change material from the
original design.
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1.4 Environmental

Area of Possible Concern System Information
Audible Noise Levels Below 65 dBA.
Material and Chemicals There are no known dangerous materials or chemicals

on this workcell. Refer to the MSDS sheet for the
dispensed material.

Hazards Due to Contact The workcell has safety features to minimize injuries. In
some modes of operation it is possible to override
safety features. Only qualified personnel should enter
the work area when the workcell has power. All hot
surfaces have a warning label.

1.5 Workcell Location

The machine should be installed on a level surface away from standing water, possible
overspray, and overhead leaks.

1.6 Handling, Transportation, and Storage

The workcell should be handled and transported with minimal vibration and shock on the
system. Use an air-ride truck for roadway transport. The machine is built for an industrial
environment, but excessive abuse will decrease the performance of the machine.

1.7 Storage, Temperature, and Humidity

When in storage, all enclosures and connector covers should be closed tightly. Put a cover
over the system if there is dust or other airborne debris in the storage area. Store the
workcell in an area that is 40°F - 105°F (4°C - 41°C) and low humidity. Do not let
condensation collect on the machine.

1.8 Dispensing/Spraying Equipment

When the workcell is stored for an extended period of time, it should be flushed with a
solvent compatible with the application material and workcell components.

Note: PVA is not responsible for damages incurred by incorrect transportation and
handling of the workcell. The instructions given for the transportation, handling, and
storage of the workcell are the correct manufacturer’s procedure.
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2.Installation and Setup

Before you operate the workcell, know the components. Do the steps in this manual for
safe and correct operation.

Warning: Only qualified personnel should do these procedures. Obey this manual and
all applicable safety regulations. A “qualified person” is defined as “a person or
persons who, by possession of a recognized degree, certificate, or professional
training, or who, by extensive knowledge, training, and experience, has successfully
demonstrated the ability to solve problems relating to the subject matter and work."”
(Ref. ANSI/ASME B30.2-1983.)

2.1 Uncrate and Inspect

1. Use the Utility knife to cut the straps and the shrink wrap.
2. Remove the cardboard as well as all packing materials and straps.

3. Use a 9/16" wrench to remove the shipping bracket from the crate. Use a 3 mm hex
key to remove the four shipping brackets. There are two on each side of the
machine.

211 To Place the Dispense System

1. Move the workcell to the necessary location.
2. Loosen the lock nuts on each foot of the workcell, if necessary.

3. Make sure that all four (feet) touch the ground. If any feet do not touch the ground,
use the adjustable wrench to lower the feet by turning the feet clockwise.

Turn Clockwise to Lo ockwise to Raise the

Figure 1: Adjust the Feet

NOTE: When you lower the feet, you raise the workcell. When you raise the feet, you
lower the workcell.
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2.1.2 Inspection

1. Open the doors and remove all straps, tie wraps, and sponges around the dispense
heads and gantry. In order to prevent any movement during the shipping process,
many workcells are equipped with green shipping brackets inside the machine. The
placement of these brackets will vary by workcell. The shipping brackets must be
removed before continuing the inspection.

2. Fully examine the workcell for damage, loose fasteners, etc.
3. Use your hands to move the X and Y-axis slide to the center of the work area.
4. Examine all tubing connections, gauges, and regulators.

5. Open the electrical enclosure and visually inspect connectors and components for
signs of vibration during shipping. Close the door, the machine should not operate
with the doors open.

6. Make sure all cables and connections are fully and correctly installed.

2.2 Level the Workcell

This is the procedure to level the workcell. Put the level in the center of the jig plate.

1. Look at the position of the bubble in the level window. The bubble will be centered
between the two lines when the workcell is level. If the bubble is outside or closer to
the right line, raise the left side of the workcell. If the bubble is outside or closer to
the left line, raise the right side of the workcell.

2. If necessary, loosen the locking nut on each foot with an adjustable wrench.

3. Use an adjustable wrench to adjust the feet of the workcell. Put the wrench on the
flat (unthreaded) part of the pedestal and turn in the necessary direction until the
workcell is level from side to side. Turn the pedestal clockwise to raise the workcell
and counterclockwise to lower the workcell.

4. In each corner, put your hands on top of the workcell and push down. If one of the
feet does not touch the ground the workcell will rock back and forth. Adjust the feet
so that they all bear equal weight.

5. When the workcell is level from front to back and side to side, is stable, and all four
feet bear equal weight, use your hand to turn the locking nuts on the workcell feet
counterclockwise until they are tight.
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2.3 Power Up

After the accessories are installed, connect the workcell to air and power supplies. After
the workcell is correctly connected, turn the main power switch “On” and make sure
system components function correctly.

WARNING: Failure to obey electrical specifications can damage the machine and
injure personnel. Electrical hookup must be done by a qualified electrician and must
comply with any applicable local standards.

1. Plug the machine into an appropriate power source as shown on the legend plate on
the right side of the machine.

The electrical service must be correctly grounded and the power source “clean”. If high-
power equipment uses the same source, a line conditioner may be necessary. Poor power
quality can cause machine errors. All workcells shipped from the PVA factory can operate
with the voltage used at the installation site, per engineering design.

WARNING: Make sure that the main power switch is “Off” before you connect the
workcell to the facility power source.

2. Find the main air regulator.

3. Attach the workcell to the facility air supply. There is a %" NPT female fitting at the
rear of the machine. Connect to a source of clean, dry air. A hose of %4" inside
diameter is sufficient.

4. Slowly open the facility air valve.
5. Close any access doors and engage in the Emergency Stop button.

6. At the top of the machine, turn on the red air lockout valve.

Figure 2: Red Air Lockout Valve
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NOTE:

Ground any pressure vessel to earth or the machine.

Attach a correctly designed ventilation system to the exhaust port. It is necessary
that the exhaust flow is correct for the specified CFM of your workcell.

Refer the Material Safety Data Sheets (MSDS) for safety precautions on any

chemicals used in PVA equipment.

NOTE:

Do not power on the workcell or add material to the pressure vessels until they

are correctly grounded.

9.

Turn the main power switch “On”.

Figure 3: Main Power Switch

Perform the homing routine through the HMI.

Manually jog to make sure there are no components that can be hit by the head in
the work area.

Make sure that the pneumatic and electrical cables do not decrease the heads travel
and will not be cut or snagged when moved. Please contact Technical support if
there are any problems.

Make sure the valve and brackets are tight and that the valve does not rock or
wiggle in the bracket.

Close the doors.
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2.4 Necessary Downloads

Prior to operating Sigma, please visit contact.pva.net/sigma-manual to download a copy
of the manual, Inkscape, and the PVA G-code Generator. This URL should be included on

your machine.

1. Access contact.pva.net/sigma-manual via browser.

@ contact.pva.net/sigma-manual/

Sigma Manual Inkscape Download G-code Generator

20:0:0/g

Prior to use, you must complete the steps below.

v/ Read Sigma Operation Manual

Download, Print, or Copy Link to Share.

Choose From 32-Bit or 64-Bit Inkscape Download.

G-code Generator

+ Install PVA G-code Generator Extension

Copy Files from Zip File into C:\Program Files\Inkscape\share\extensions

v Download Inkscape Version 0.92.4

Figure 4: Sigma Download Website
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2.41 Sigma Manual

The Sigma manual will walk you through how to install and operate Sigma as well as how to

use Inkscape and the web interface. Read this manual carefully prior to use.
1. Click View Manual.

2. From this screen, you can download, print, or copy link to share.

I& Share @ Copylink @31 Print Y Download [l Delete [ Copyto & Version history

INNOVATION. PRECISION. EXCELLENCE.

=
Y SIGZA
Sigma Benchtop Robot

Owner’s Manual

Revision A

Precision Valve & Automation
i Sigma Manual - REV Apdf pVA

10of1 X @

Figure 5: Download Sigma Manual
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2.4.2 Download Inkscape

Sigma is designed to work exclusively with Inkscape version 0.92.4. Prior to use, Inkscape
version 0.92.4 must be downloaded.

1. Click Download Inkscape.
2. Choose between 32-bit and 64-bit.

3. Follow the download prompts.

@ inkscape.org/release/0.92.4/windows/ Q,
INKSCAPE .
@fﬂqw {fl-“({ (L«; ‘_Search website ﬁ\

ABOUT DOWNLOAD NEWS COMMUNITY LEARN CONTRIBUTE DEVELOP SUPPORT US

Home » Releases » Inkscape 0.92 » Inkscape 0.92.4 » Windows

Q INKSCAPE 0.92.4
- - Draw Freely

32-bit 64-bit Windows 10S App Store

fr?

i 32-bit architecture My 64-bit architecture ; Windows Store
3 ay 1 |

1

Figure 6: Download Inkscape
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2.4.3 Install PVA G-code Generator Extension

Prior to use, the PVA G-code Generator extension must be installed within Inkscape.

1. Click G-code Generator.

2. When the screen opens, select all files and click Download.

4 Download | [i] Delete 53 Moveto [ Copyto 17 Sort v X 2selected = v~ @
Files > PVA G-code Generator Extension
Q@ [0 Name Modified Madified By File size Sharing
(] [ 2020-05-12 v1.0.0_PVA (1).py = June 1 Kim Fagan 159 KB A Shared
(/] [ 2020-05-12 v1.0.0_PVA.inx e - June 1 Kim Fagan 423 KB £ Shared

Figure 7: Install PVA G-code Extension 1

3. The zip file will open in Windows Explorer.

4. Copy the files and paste them into the following Windows Explorer folder:
C:\Program Files\Inkscape\share\extensions

xtensions

Share View

Paste

lipboard

D Cut
W Copy path

Move Copy
[#] Paste shortcut .

X

Delete Rename
to to -

Qrganize

MNew
folder

TJ New item ~

’Tj Easy access ™

New

Open BH
v
Edit
Properties
- History

Open

| » This PC > Windows (C:) > Program Files > Inkscape » share > extensions

ds

CH (A)

(&)

zed Work (F:)
)

bl
Service (L)
ing (M:)
ng (N:)

~ Name

alphabet_soup
Barcode
ink2canvas
Poly3DObjects
xaml2svg
= addnodes
addnodes

wii, (v

ai_input

= aisvg
]

B aisvg

é bezmisc
= cox_input
= cdr_input

= cdtinput

~

Date maodified

View
Sort by
Group by
Refresh

Select all

Select none

Select

EF Invert selection

Type

v

Customize this folder...

Paste
Paste shortcut
Undo Delete

Ctrl+Z

Give access to

New

Properties

er

er

er

er

er

XML Inte...
crobat D...
XML Inte...
XML Inte...

sform

crobat D...
XML Inte...
XML Inte...

XML Inte...

2KB
5KB
1KB
1KB
2KB
9KB
1KB
1KB
1KB

Figure 8: Install PVA G-code Extension 2
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3.0perating Safety

The workcell has several safety features that protect the operator from hazards in normal
machine operation.

Warning! The safety features should NEVER be bypassed, disabled, or tampered with.
PVA is not responsible for any damage, mechanical or human, caused by changes or
destruction of any safety features.

3.1 Safety Circuit

The main power to the workcell is monitored and controlled by the safety circuit. The
safety circuit contains two relays under-voltage protection and one or more safety
devices. The relays are wired in a redundant manner. The tripping contacts of the relays
are connected in series so the safety circuit will disconnect power even if one of the relays
fails. The relays are self-checking with positive guided contacts electrically forced to
operate together. If one redundant relays fails or a safety switch is activated, the power
contacts are opened.

3.2 Polycarbonate and Safety Glass Guarding

The work area is enclosed with either polycarbonate or safety glass guarding. The front of
the workcell is either open, for the manual processing of parts, or has doors.

3.3 Doors

The doors on the workcell are monitored during the dispense cycle. If the door is opened
while the machine is in operation, this will trigger a pause on the machine.

3.4 Exhaust Fan

The exhaust flange should be connected to a duct system that can receive the required*
CFM (cubic feet per minute) while maintaining less than 1.0” H,0 static pressure in the
duct. If airflow through the exhaust system is not sufficient, it will generate an error.
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3.41 Standard Machine Exhaust Requirements

. Air Velocity at Air Velocity at
Machine E::hzli‘ritmen t hsdiaz:hme Duct Test Point Test Point
9 (ft/min) (m/sec)
Sigma 250 CFM 3" (76.2 mm) 4166 21.16

Note: Check machine specifications. Custom order machines and processes may
require higher exhaust flow rates.

Note: Refer the Material Safety Data Sheets (MSDS) for safety precautions on any
chemicals used in PVA equipment.

Note: The safety devices on your workcell will be different with each model.

3.5

Notices and Warnings

You must wear safety glasses, gloves, and long sleeves

Lock-out and tag the air and power supplies before you service or clean any part of
this equipment

Release the pressure before any hose (air or fluid) is removed
All hoses must have the correct pressure rating
Use only replacement parts recommended or supplied by the manufacturer

Stay away from all parts that move when the system is in operation
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4.Inkscape

Inkscape is an open-source vector graphics editor. PVA has created an extension designed
to convert what is drawn in Inkscape to a G-code file that can be uploaded to Sigma. Sigma
is designed to work with Inkscape version 0.92.4. Inkscape must be downloaded prior to
use. Download instructions were included with Sigma.

41 Inkscape Manual

This manual will cover the basic functions needed to create a dispense path in Inkscape as
well as the PVA G-code Generator extension. For more information on how to use Inkscape,
please refer to the Inkscape manual.

411 Accessing Inkscape Manual

1. Select Help 2 Inkscape Manual. The Inkscape manual will open in your browser.

Q MNew document 1 - Inkscape
Eile Edit View Layer Object Path Text Filters Extensions Help

DEEE BB @@ | Deed @&Q@ T Inkscape Manual B H
FEF IEY Y I  [GooomH +: [ Keys and Mouse Reference = p—
Ask Us a Question
k ;.\.|'.4w|.|.\.|'.4"?q|.|.|.|'|3w‘.|.|\|'§W\.|.|\|'gﬂ\.|.|.|'1j"r'q|.|. Toarels ' L
f{:' 2] Command Line Options
] FAQ
1 New in This Version
Report a Bug

SVG 1.1 Specification

raa

E About Memory
® About Inkscape

POSOh

Figure 9: Access Inkscape Manual

C O © Notsecure | tavmjongfree.fi/INKSCAPE/MANUAL/html/index php Y
a R = Get th
Inkscape: Guide to a Vector Drawing Program PookeeEBodN
Older versions: 0.16: English, Espa€ol, 0.15: Fran€ais, 0.14: Italian.
Fifth Edition ( - h
Tavmjong Bah Available in print, pdf, and ebook formats:

0.17 (Documenting Inkscape versions 0.92 and 0.93)

Inkscape
Guide to a Vector

Available from Prentice Hall as a book or as an ebook.
This book has a website with additional material. Go to: http:/tavmjong.free.fr/INKSCAPE/.
Suggestions and corrections are welcome and can be sent to tavmjong @ free . fr.

Copyright € 2006-2017 Tavmjong Bah

This book in HTML form is available for personal use only. It may not be reproduced and distributed in any
form without the consent of the author.

Table of Contents

« Acknowledgments In stock at:
« Introduction Informit.com, Amazon.com, BarnesAndNoble.com. and
. j._gulck Start many other online bookstores.

Figure 10: Inkscape Manual
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4.2 Setup

1.

Once Inkscape is open, select File > Document Properties from the taskbar.

4 New document 1 - Inkscape - X
File Edit View Layer Object Path Text Filters Extensions Help
New Cul+N . loooo = v:(0000 = w0000 = & H: (0000 jmm[v|[/= |3 ==
1 New from Template... Cirl+Alt+N w, R ) o, P, Lep @ ? o s
E Open... Ctrl+0 ~ e
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=
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@ Save As.. Shift+Ctrl+S £ 3 N
Save a Copy... Shift+Ctrl+Alt+S :’i o
+1 Import.. Ctri+l %
@
[> Export PNG Image... Shift+Ctrl+E O B
= Import Clip Art.. S & v
& Print.. Ctrl+P 2y~
= 5
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& Clean up document Q o
' Document Properties... Shift+Ctrl+D g o .
® Close Ctrl+W g o,
4 Quit crri+Q [ 1 g4 @ ‘

Figure 11: Select Document Properties

2. The Document Properties popup window will display. Under Custom Size, set the
Sigma workspace dimensions (330 mm X 300 mm).

Height: |300.00000

Resize page to content...

Q Document Properties (Shift+Ctrl+D) — x
¥l Document Properties (Shift+Ctrl+D) & ®
Page Guides Grids Snap Color Scripting Metadatd Note: |fa template has already
General
been created for the
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Background color:

Display
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Scale
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Figure 12: Set Workspace Dimensions
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421 OpenaTemplate

1. To open a pre-existing template, select File > New from Template.

The New From Template window will open.

4 New From Template >

Search: o drawing

330mm % 300mm

Business Card...

CD Label 120mmx120mm
default pt

default px

Desktop...

DVD Cover...

Generic canvas...

lcon...

LaTeX Beamer b4 More info

Create from template

Figure 13: New From Template

2. Select the desired template from the list or use the search bar.
3. Highlight to view the template details.
4. Double-click the template or select Create From Template.

The template will open as a new document.

cow

1©LOb

Q New document 4 - Inkscape - O X
Eile Edit View Layer Object Path Text Filters Extensions Help

DBEHE b ¢¢ DD Q@@ D SH FToaEEIB®
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Figure 14: New Document from Template
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4.2.2 Create aNew Layer
1. Select Layer - Add Layer or Shift+Ctri+N.

2. Enter a Layer Name for the substrate and click Add.

File Edit View Layer Object Path Text Filters Extensions Help
EE i * Add Layer... Shift+Ctrl+N § 5 3 =2 =
& Rename Layer... c
g | ks b BRI, R and Stroke (Shift+Cirl+F) B85 [O%
p— ] Show/hide Current Layer ~ il x =
o int = o]
% 3_ Lock/Unlock Current Layer Fil Stroke paint = Stroke style E, - %,
e o] =
¥ £ Switch to Layer Above Ctrl+Page Up X Q Q ﬁ Eﬁ m ? vw ﬁ 2
Q, ] & Switch to Layer Below Ctrl+Page Down No objects E B 'f
% 1 *® Move Selection to Layer Above Shift+Page Up ué S
D ] & Move Selection to Layer Below Shift+Page Down ;l: """
@ 3] L Move Selection to Layer... - @ %
o] o
O = Raise Layer Shift+Ctrl+Page Up L?j @
Q} ] =/ Lower Layer Shift+Ctrl+Page Down b B #
N +
#® Layer to Top Shift+Ctrl+Home = pY
@ 4 . Y g
@& Layer to Bottom Shift+Ctrl+End = %
@ 7 : £ 0
0 uplicate Current Layer - . 2
= Duplicate Current L = z I
N A & Delete Current L B 0. 5 @
4 8 Delete Current Layer @ Add Layer X Opacity &0 1000|‘ £ -,
q aci I
l@' 2 Layers... B i i @ o
AI 7 Layer name: PCB| % (]
= +
J
i, Paosition: Above current >
& T A
& 8] Cancel Add 0
$ ] | B

3. You can view and toggle between layers in the layer dropdown on the bottom left of

the screen.

Figure 15: Add New Layer
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Figure 16: Layer Dropdown
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4.3 Importimage (Optional)

There is an option to import an image of the substrate as a reference for the dispense path.
Ensure that the reference image is scaled correctly. Skip this section if it does not apply.

1. Select File > Import or Ctri+l and select the file to import.

4 *New document 2 - Inkscape - [m] x
Eile Edit View Layer Object Path Text Filters Extensions Help
New al+N | Q@ Q Daw SEH BPT=EEI B &
1 s iam e CuirAlteN | (000 = v:[oo00 = w:[ooo = & w[oooe Efmm[¥](|2]5]=]=
& Open... Ctrd+0O
Open Recent ' (oI o T T L T - N T W S O P S WO PO - PO I . U ST P W < T - A
Revert %
= Save Ctrl+S
E Save As... Shift+Ctrl+S i
Save a Copy... Shift+Ctrl+Alt+S -
= ¢
2 import. e _
[ Export PNG Image... Shift+Ctrl+E
“ Import Clip Art... N,
& Print.. Ctrl+P v
< Clean up document ~
¥
2l Document Properties... Shift+Ctrl+D -
¥ Close Ctrl+W i
@ Quit Ctrl+Q
v "
1
Al : +
. 4
>
Fill: N/A = - . - B B - _ X-224.52 _[ __ @&
Stroke: N/A 00 ~|% 3 -PCB Import a bitmap or SVG image into this document ¥ 337.15 Z: 35% 5

Figure 17: Import Image

2. From the JPEG Bitmapp Image Import window, choose the Image Import Type,
Image DPI, and Image Rendering Mode.

3. Click OK to continue.

Q jpeg bitmap image import X
Image Import Type: ) Embed

@ Link
Image DPL: @ From file

) Default import resolution
Image Rendering Mode: ® MNone (auto)

) Smooth (optimizeQuality)

O Blocky (optimizeSpeed)
[ Don't ask again

Figure 18: Import Image
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Note: There is also an option to paste the image onto the active layer. Simply use
Ctrl+V to paste the image onto the workspace.

The image will display in the workspace window and can be resized.
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Figure 19: Image Example
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4.4 Transform Image

Resize the substrate image to its accurate size.

1. Select the image.

2. Select Object = Transform or Ctri+Shift+M to open the Transform panel. This
panel offers the ability to Move, Scale, Rotate, and Skew the image if necessary.

Q *New document 2 - Inkscape — O X
File Edit View Layer Object Path Text Filters Extepsions Help
ODBEBEE BB | = objecs. TFTaRE B ®
B 2 Selection sets... 7195 @ H 7616475 mm|v|| 2 3 =W =
e 3% 9, # Fill and Stroke.. Shift+Ctrl+F P Transform (ShiftCurl+M) EICHES
=l i Object Properties... Shift+Ctri+0 Il
f\ @ Symbols.. Shift+Ctrl+Y 17 Move 5Scale Rotate Skew Matrix o,
£ ] & Group il [ width: |100.000 =N
Q ] # Ungroup Shift+Ctrl+G ] Height: 100.000 = i
% é_ & Pop selected objects out of group [ Scale proportionally 4
@ ] Mask 4 %,
Pattern » [ Apply to each object separately ~
O ] Objects to Marker #
@y 7] Objects to Guides Shift+G Clear Apply
o ¥
@ 1 £ Raise Page Up i{ Object Properties (Shift+Ctrl+0) A .,
23 ; 5 Lower Page Down M | = Transform (shift+Ctri+M) <l o
i? £7 Raise to Top Home
-[g ] L2 Lower to Bottom End R
A i & Rotate 90° CW =
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2 1 Unhide All it
[ T
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Figure 20: Transform and Object Attributes
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441 MoveTab

Use the Move tab to translate an object. An object can be moved horizontally or vertically.
Use the arrows or enter a value manually in the field.

An object will be translated relative to its current position if the Relative checkbox is
selected. If the box is not checked, the lower-left corner of the objects bounding box will
be moved to the given coordinate.

HTransform (Shift+Ctrl+M) = ®
Ho Horizontal: |0.000 : mm |
18 Vertical: 0000 =
Relative mave
L] Apply to each gbject separately
Clear Apply

Figure 21: Move Tab

442 ScaleTab

Use the Scale tab to scale an object. An object will be scaled relative to the center of its
bounding box.

Use the dropdown to change the units and manually enter the correct size in millimeters.
The Scale Proportionally option forces the width and height to scale by the same
percentage.

HTransform (Shift+Ctrl+M) = =
Move Scale Rotate Skew Matrix
NN YV 100.000

[l Height: 100000
L] Scale proportionally

L1 Apply to each object separately
Clear Apply

Figure 22: Scale Tab
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4.4.3 Rotate Tab

Use the Rotate tab to rotate an object. An object will be rotated relative to Rotation center.
The direction of the rotation is positive in the counterclockwise direction.

FTransform (Shift+Ctrl+M) = ®

Move Scale Rotate Skew Matrix

O Angle: N D0 v &

L Apply to each object separately
Clear Apply

Figure 23: Rotate Tab
444 Skew Tab

Use the Skew tab to skew an object. An object can be skewed in horizontal and vertical
directions separately. The skewing is relative to the center of the bounding box. The
magnitude of the skew can be specified as a distance, percentage, or angle. In all cases,
the skew is relative to the size of the bounding box.

HTransform (Shift+Ctrl+M) = &
Move Scale Rotate Skew Matrix
nﬂorizontal: M : ° b
' Vertical: 0.000 =
L] Apply to each object separately

Clear Apply

Figure 24: Skew Tab

Note: Width Height, XY Position, and Rotation of the image can also be edited from
the Tool Controls Bar.

File Edit View Layer Object Path Text Filters Extepsions Help

Ml
W
A

]

B |y 2 LE S = 57| k0000 3 w0000 3 W2500003 8 H 1571335 mm v

Figure 25: Tool Controls Bar
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445 Movelmage

There are three options to move the image to match its location on the workspace.
Note: The X and Y coordinates will be the left-hand corner of the image.

e Click and drag the image to its desired location. The position can be
monitored by using the scale at the top in the Tool Controls bar or in the
bottom right-hand corner in the Pointer Position window.

e Manually enter the X and Y position in the Tool Controls bar.

e Use the Move tab in the Transform panel.

Q *New document 2 - Inkscape - O X
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Figure 26: Move Image
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4.4.6 LockLayer

After the substrate image is resized and positioned in the desired location, PVA
recommends locking the layer. There are two ways to lock a layer.

e Select the image. Select Layer > Lock/Unlock Current Layer.

e Select the image. In Layer Information at the bottom of the screen, select the layer
that should be locked. Click the Lock icon to lock the layer.

Q *New document 2 - Inkscape - O

FEile Edit View Layer Object Path Text Filters Extensions Help
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RN L ST LT SOOI T VPV NONY I
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% % Move Selection to Layer Below Shift+Page Down =

D 4 Move Selection to Layer...

) ﬂmmm_

@ e = Raise Layer Shift+Ctrl+Page Up N
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;!lr:oke Eﬁ oo I|% a .PcB ~ |\Ctrl: click to select in groups; drag to move hor/vert i:: lz::gi Z| 66%

Figure 27: Lock Layer
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4.5 Create Dispense Path

This section will review how to create a dispense path. It is recommended that each tool
have a unique layer for its dispense path.

Note: The robot will follow the dispense path based on the direction that a line was
created.

451 Createaline

1. Once a new layer has been created, select or Shift+Fé6 to select the Pen tool.

Lo
2. Select the desired Mode from the Tool Controls bar 2% € ™ % =

1

Create regular path

2

Create Spiro path

NI

Create BSpline path

Create a sequence of straight line segments

Sl S

Create a sequence of paraxial line segments

Figure 28: Mode Options
3. Click on the desired start point to begin the line.

Figure 29: Starting Point

4. Click a subsequent point along the line to add a control point (node).
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5. Continue drawing additional segments if necessary.

6. Hit Enter to complete the line or click on the first endpoint when placing the last
endpoint.

Figure 30: Completed Line

45.2 Editaline
1. Use the Select tool and click the line that needs to be edited.

2. Toresize the line, click and drag the white arrows to scale.

Figure 31: Resize Line

3. Use the Arrow keys to move the last node created while drawing a path.
Shift+Arrow moves the node by ten times the normal step,

4. To delete the last node drawn, use the Backspace key or Delete key.
5. To delete an unfinished path, use Esc or Ctri+Z.

6. To extend a previously drawn path, select the path, then click or click-drag on an
end point.
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4.5.3 Create aCircle

Circles are used to represent dispense dots. If a full circle is drawn, the center point of the
circle is where the valve will dispense.

1. Select the Circle tool O .

2. Click and hold at the start point of the circle. Drag to create the circle.

Figure 32: Create Circle
Note: To create a perfect circle, hold Ctrl as you click and drag the circle.

4.5.4 EditaCircle

1. Using the Select tool, click on the circle that needs to be edited.
2. Use the arrows to resize the circle.

3. To move the circle, click and drag the circle to a new location.

- __“Hl' _____._-_,q-,_ =
I O,E%m !

Figure 33: Resize Circle
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455 CreateanArc

If an arc is drawn, the path will follow the start point of the arc to the end point.

1. Use the Select tool h to select the circle that should be changed to an arc.

2. Once the circle is selected, select the Node Editing tool N .

3. Click and drag the white node to create a start and end point.

Figure 34: Create Arc
4. Select the Circle tool and the Switch to Arc command.

& & | @

1 |Switch to arc (unclosed shape)

Figure 35: Switch to Arc Command
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45.6 EditanArc

1. Use the Select tool and select the arc that needs to be edited.

2. Toresize the arc, use the white arrows.

Figure 36: Resize Arc

3. To move the arc, click and drag.

4. To edit the starting point, use the Node Editing tool. Click and drag the white circle
to move the start and end points.

ENIG P/N

Figure 37: Edit Arc Starting Points

4.5.7 Node Tool
Dispense paths can be edited using the Node Tool. This flexible tool enables the addition,
deletion, and movement of nodes.

1. Select the Node Tool by clicking on the M icon.

2. Select the object that needs to be edited. Once selected, the nodes will appear on
the object.

3. Use theicons in the Tool Controls bar to edit the node. See table on next page.
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F - E|E IR mEm | VYR ST | 1715300 vi[10eaalimm v | F S | MY O

Insert new nodes into selected segments. Clicking on the path will select the

_E_ nearest node on both sides of the point where the path was clicked. Double-
clicking on the path will also insert a node.

r=s Delete selected nodes.

g0 lected endnod

* oin (merge) selected endnodes.

- Break path at selected nodes. Each selected node is converted into two end

88  nodes.

Ef: Join selected endnodes with a new segment.

88 .

g*s Delete segment between two non-endpoint nodes.

Figure 38: Node Tool Icons

4.5.8 SetFilland Stroke

The fill and strike of lines, circles, and arcs can easily be edited for more visibility while you
are working. There are four ways to change the fill and stroke:

1. Select Object = Fill and Stroke.

Q *drawing.svg - Inkscape

Eile Edit View Layer Object Path Text Filters Extensions Help

DEEE BB 2 objects. *E i |
=Y i o

B O E &L a Selection sets... b B & |
8 | 5o, # Eilland Stroke... Shift+Ctrl+F | |

h i Object Properties... Shift+Ctrl+ 0

N § @ Symbols.. Shift+Ctrl+Y

£ “ Group Ctrl+G

Q b = Ungroup Shift+Ctrl+G

% lr‘_ &t Pop selected objects out of group

o 5] Clip 8
- Mask 3

D K

Figure 39: Fill and Stroke Option 1
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2. Use Shift+Ctrl +F.

ZFill and Stroke (Shift+Ctrl+F) 3]

Eill T Stroke paint = Stroke style

x OOOEEDO? ow

Flat color

RGB HSL CIMYK Wheel CMS

R | ] |255
o T ] s

Ak (A Ak ATk

‘| o
s R o5
e S RGBA; ffHfO0ff

Figure 40: Fill and Stroke Option 2

3. Navigate to the fill and stroke area on the bottom left of the screen.

Fill: -
Q|0 -
Stroke: 0.5

Figure 41: Fill and Stroke Option 3

4. Use the color toolbar on the bottom of the screen.

Set fill
5 Set stroke

2 Delete
Edit...

| Convert P
FEEETS ———H

Figure 42: Fill and Stroke Option 4

Revision C / March 2023 Page 39 of 69




@ Sigma Operation Manual

4.6 Edit Path Order

By default, the G-code will follow the order in which the dispense path was created. It will
be generated from the upper most layer to the bottom layer. In the event that an
application requires certain areas to be coated first or you need to reduce cycle time, the
layers and path objects can be viewed and modified via the Objects window.

Select an object or layer and use the icons below to arrange them in the desired order.

[=0bjects E ®
VL T CMHLLabel

W @ = H g57

% a = H = Dispense Board High comp

% 3= Dispense_Board_High_comp__Layer_Settings
% a L Dispensing Board High Comp_T
Dispensing Board High Comp_2

Dispensing Board High Comp_3

&
2
ERN =N =l =) =N =l =

% @ L Dispensing Board High Comp_4

% @ L Dispensing Board High Comp_5

R P - .- hd
+ = IR N g -
Blend mode: |[Normal d
Blur (%) 007

Opacity: B 000 %

Figure 43: Edit Path Order

Move to Bottom

|+§ Collapse/Expand All
T Move to Top
4 Move Up

3 Move Down

2

Figure 44: Path Order Icons
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5.PVA Gcode Generator

The PVA Gcode Generator is an extension that will create a G-code based on what is drawn
in Inkscape.

1. To open PVA G-code Generator, select Extensions > PVA - PVA Gcode
Generator.

o
X

Q *New document 1 - Inkscape -
File Edit View Layer Object Path Text Filters Extensions Help

Gy oAb || LE
LTI . ST L DA - T DT AT

H Arrange
— Color

g7 85 | w|od Previous Extension Alt+Q pm|~|| 2 2 2 =
Previous Extension Settings... Shift+Alt+Q

i
wp

PO - I L T = I I < ST S O
~

m
Paltd

(=1 T

e e

oo

Document

Export

Geodetools

Generate from Path
Images

Jessylnk

Modify Path

PVA

Raster

|

PVA Geode Generator...

ry ¥ v v v v v v v v w

‘trl+X) E:Object Properties (Shift+Ctrl+0) |
L

ECAOX SANE POy

LV N

PVA Gcode Generator Window will display.

Q PVA Gecode Generator X

Build Path Layer Settings Path Object Settings Help

Builds the gcode file. Each active layer will need layer
settings and each selected object will need it's
settings set before the gcode file can be built.

Dry Mode
Directory: | C\Users\kfagan\Desktop\Gcode folder

Filename: drypath.gcode

Add numeric suffix to filename

Close Apply

Figure 45: PVA Gcode Generator
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5.1 Build Path

The Build Path tab builds the G-code file. Each active layer will need layer settings and
each selected object will need settings applied before the G-code file can be built.

4 PVA Geode Generator X

Build Path Layer Settings Path Object Settings Help

Builds the gcode file. Each active layer will need layer
settings and each selected object will need it's
settings set before the gcode file can be built.

Dry Mode
Directory: | C\Users\kfagan'Desktop\Gcode folder

Filename: drypath.gcode

Add numeric suffix to filename

Figure 46: Build Path Tab

511 Dry Mode

The Dry Mode option will remove the tool on commands from the G-code so the path can
be run without opening the valve. This will allow the user to test the dispense path without
dispensing any material.

5.1.2 Directory

The Directory field is where the G-code file will be saved on the computer. There is no
browse option; the address must be manually entered. Once a directory address is entered,
it will be retained until it is changed.

5.1.3 File Name

The Filename field is where the G-code file name will be entered. To add a numeric suffix to
the filename, select the checkbox below. This will assign a new file number to the end of
the filename each time a file is created.
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5.2 Layer Settings

The Layer Settings tab applies the following settings to the selected layer. Any settings
entered will not be applied until Apply is selected.

4 PVA Geode Generator pet
Build Path Layer Settings Path Object Settings Help
Applies the following settings 1o the selected layer.
Action |Set Layer Settings =
Travel Speed (mm/min or in/min): 3000.0000 :
Safe Z Height (mm/in) 50,0000 :
Close Apply

Figure 47: Layer Settings
5.21 Action

e SetLayer Settings: This action will apply settings to the active layer.

o Display Layer Settings: This action will display all settings for the active layerin a
text box.

o Hide Layer Settings: This action will hide the text box settings for the active layer.

¢ ImportLayer Settings from Displayed: This action will load the settings from the
active layer.

5.2.2 Viewing and Editing Layer Settings

Prior to generating the G-code file, you can view layer settings to make any changes.

1. Select the desired layer and select Extensions > PVA - PVA Gcode Generator.

2. Navigate to Layer Settings. Under the Action dropdown, select Display Layer
Settings.

3. Perform this action for all layers that you would like to view settings for.
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The Layer settings will display next to the workspace.

4. Right-click to adjust the fill and stroke of the layer settings for visibility.

= Undo: Move Ctrl+Z
@ Redo Shift+Ctrl+Z

#a Cut Ctrl+X
) Copy Ctrl+C
O Paste Ctrl+V

Duplicate Ctrl+D
& Delete Delete

Fill and Stroke...
Object Properties...

Figure 48: Layer Settings Fill and Stroke
5. To edit any of the layer settings, select the Text tool Al.

6. Select the parameter that needs to be edited and make the necessary edit(s).

Figure 49: Edit Layer Settings

7. Open the PVA Gcode Generator and navigate to Layer Settings.
8. Under the Action dropdown, select Import Layer Settings from Displayed.

The Layer Settings will update.

5.2.3 Travel Speed

Enter a Travel Speed that the robot will travel while it is not dispensing.

5.2.4 Safe ZHeight

After each dispense segment, the robot will move to a configured Safe Z Height before
moving to the next dispense location. Enter a Safe Z Height for that layer.
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5.3 Path Object Settings

The Path Object settings applies the settings below to the selected path object(s). Leaving
the ID Blank will apply the settings and leave the ID unchanged.

Note: To select an object, the layer must be unlocked.

Q PVA Geoode Generator =

Build Path Layer Settings Object Settings  About

Applies the following settings to the selected
path ohjecti(s]. Leaving the ID blank will apply the
settings and leave the ID unchanged.

Unique ID

Teocl | TO

Dispense Height (mm) 55,0000 :
Line Specific Settings:

Dispense Speed (mm/min]: 2500.0000 :

Yalve Off Distance (mm) 2.0000 :

Yalve On Time (ms) 300.0000 :
Dot Specific Settings:

Dispense Dot Time (ms) 2000.0000 :

Post Dot Dwell (ms) 500.0000 :

Close Apply

Figure 50: Path Object Settings Tab
5.3.1 UniquelD

Designates a specific name for the objects that are selected.

5.3.2 Tool

Assigns a tool to the objects that are selected. If there are two tools on Sigma, the left tool
is TO and the right tool is T1.

5.3.3 Dispense Height

Enter a Z height used for the selected objects i.e. if the circuit board is 5 mm and the
desired dispense height is 2 mm, enter 7 mm.
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5.3.4 Line Specific Settings

e Dispense Speed (mm): The dispense speed for the selected objects.

e Valve Off Distance: The distance that the valve should be closed before the end of
the selected line.

¢ Valve On Time: The amount of time the valve will be opened before the dispense
line starts.

5.3.5 Dot Specific Settings

¢ Dispense Dot Time: The time in milliseconds that the valve will dispense onto the
center point of the circle.

¢ Post Dot Dwell: The time in milliseconds that the valve will wait after dispensing
before it continues to the next dispense point.
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6.0peration

6.1 Generate G-code

1.

2.

Once the G-code is ready to be generated, open the PVA Gcode Generator.
Navigate to the Build Path tab.

Enter the Directory information.

Enter a File Name.

Select Dry Mode and/or Enable Logging if necessary.

Select Apply. The G-code will be saved in the designated directory folder.

6.2 Sigma Wireless Connection Setup

Sigma has 2.4GHz wireless network connection capability that allows Sigma to be operated
remotely with a computer. For the initial setup of Sigma, you will need to use this feature.

Turn on Sigma using the on/off switch located near the power cord connection.

. The control screen will start up on its own.

. Connect to the network matching the serial number. The serial number is listed on

the label located on the upper right corner of the back panel on Sigma.

. The network password is “PVA12345".

Figure 51: Sigma Serial Number Wi-Fi Network
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5. Once connected to the network, access the computer interface by typing the
machine IP address “11.22.33.44" into your Firefox or Chrome browser.

The web interface will display.

PVA 3 2 | Send G-Code Asend | #Upload & Start | [RE RSN RNES [01]

@ Machine Status / Tools | & Heaters / + Extra = Control All v @ Temperature Chart
Head X Y z Tool Heater Current Active Standby
Position 290.00 290.00 100.00 TOOL 0~ 250
T0
Extruder Drive 0 Drive 1 TooL 1~ 200
Drives T
0.0 0.0 150
Requested Speed Top Speed
Speeds 100
0 mm/s 0 mm/s

Vin MCU Temp.  Z-Probe
Sensors

242V 316 0
A Machine Control [ Home an | Head Movement User-Defined Macros
124 Job Status m < X-50 < X-10 < X1 < X-0.1 X+0.1> X+1 3 X+10 > X+50 ¥ TOON
T0 OFF

Home Y < Y-50 < Y10 < v < vo1 Y+0.1 > v+ > Y+10 3 Y+50
> G-Code Console TO MAT PRESS ON

Home Z 725 z5 705 7005 7+0.05 7405 745 7425
- ome < < < < > > > > TO MAT PRESS OFF
& G.Code Files

Deselect Tools
& Macros Extruder Control
Feed amount in mm: Feedrate in mm/sec

O Filaments 100 50 20 “ 5 1 60 30 15 _ 1

£ Settings

Figure 52: Sigma Web Interface Home Screen
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6.3 Connect Web Interface to Existing Network

There is an option to connect an existing 2.4 GHz WiFi network to the web interface.
Note: This option is not compatible with 5 GHz networks.

1. Use the steps outlined in Sigma Wireless Connection Setup to connect to Sigma'’s
WiFi network.

2. Once connected, access the web interface.

3. Navigate to the G-Code Console.

& Machine Control ? | Send G-Code I Clear Log | ™ Download as ~

3:55:52 PM
3:29:10 PM Connection established!

3:29:10 PM Page Load complete!
>_G-Code Console

A& G_Code Files

=1 Job Status

& Macros

@ Filaments

£ Settings

Figure 53: G-code Console

6.3.1 M587 Command

The M587 command will be used to send your desired network information to the web
interface’s G-code console. The M587 command must include three components.

1. S:Network SSID
e Must be enclosed in quotation marks
o Case-sensitive
2. P: Network Password
e Must be enclosed in quotation marks
o Case-sensitive
3. 1:IP address to use when connected to this network (optional).
e If zero is entered or not specified, an IP address will be acquired via DHCP.
The M587 command must be written in the following format:

M587 S"WIFI_NETWORK_NAME" P"PASSWORD" IX.XXX.XX.XXX
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Example:
Network SSID TEST_Network
Network Password Testing123
IP Address 1.160.10.240

Using the credentials listed above, the M587 command would be as follows:

M587 S"TEST _Network” P"Testing123" 11.160.10.240

1. In the Send G-code field, enter the full M587 command.

2. Click Send. A connection established message will appear.

A Machine Control 7[ M587 S"I P " 11 m @ Clear Log I Download as ~

=4 Job Status 3:22:46 PM Connection established!
3:14:55 PM Disconnected.

3:12:18 PM
>
> G-Code Console 3:06:07PM  Connection established!

B _Code Files 3:06:07 PM Page Load complete!

& Macros

@ Filaments

¥ Settings

Figure 54: Enter M587 Command

Additional Commands:

e To view stored networks, enter M587
e To see the current network connection and IP, enter M552
e Toremove the network from memory, enter M588 S"NETWORK_NAME"

e Toremove all networks from memory, enter M588 S"*"
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6.3.2 Change Web Interface to Client Mode

1. To switch the web interface network from host mode to client mode, select

Settings.

2. Select System Editor.

3. Navigate to the config.g file and right click. From the menu, select Edit.

# Machine Control General User Interface List Items System Editor Machine Properties
1 Job Status ' System Directory

O File Name {3 Size
*_G-Code Console .

O W apexconfig.g 3.1KiB
B G-Code Files -

O B bedg 177B
&
& Macros O B BEGING 458

O W cancelg 59B
Q Filaments

i ) B confag 3.3KiB

R & Download

O B co 3.3KiB

A # Edi
O B oge 7 Ed 1858
T Rename
O B DU xpelete n 393.4 KiB

Tools

i New File % Refresh

Last modified

1/22/2020, 8:20:17 AM

1/20/2020, 2:48:11 PM

1/21/2020, 12:30:21 PM

1/20/2020, 2:48:11 PM

6/15/2020, 3:28:04 PM

5/14/2020, 1:29:26 PM

1/20/2020, 2:48:11 PM

12/24/2018, 8:47:19 AM

Figure 55: Access System Editor

4. The file will open. Navigate to the Network section.

removed from the other networks.

5. To select a network, a semicolon must be placed in front of the network and

Editing 0:/sys/config.g

MAZ P3 51

Me67 S1 5 Select CoreXY mode
;DEVICE NAME
M558 P"PVA"

; Network —

;WAP

M552 S

G4 51

;M589 S"PXXXX" P"PVA12345" I111.22.33.44
M552 S2

;M552 S1

G4 s1

3 SET DEVICE NAME

SWIFL ON

; Set Network Address

;ENABLE NETWORK AS HOST
;ENABLE NETWORK AS CLIENT

= e

Figure 56: Edit Config.g File
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6. Delete the semicolon (;) from M552 S1.

7. Add a semicolon (;) to M552 S2 to select the network.

Editing 0:/sys/config.g

;DEVICE NAME
M550 P"PVA" ; SET DEVICE NAME
; MNetwork

sWAP

M552 S8

G4 S1

;M589 S"PXXXX" P"PVA12345" T11.22.33.44 ; Set Network Address
;M552 S2

M552 S1

G4 S1

SWIFI ON

;ENABLE NETWORK AS HOST
;ENABLE NETWORK AS CLIENT

=

Figure 57: Change Network
8. Click Save Changes.

Note: The web interface must be rebooted after changes to the network have been
made.

9. Click Yes to reboot the web interface.

© Reboot Duet?

You have just uploaded a config file. Would you like to reboot your Duet now?

3 3

Figure 58: Reboot Confirmation

The web interface will confirm the file was successfully updated.

® File Updated

The file O:/sys/config.g has been successfully uploaded.

Figure 59: File Updated
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The control screen on Sigma will confirm that the machine is connected to the network.

Response

WiFi module started

Control Console

The network and IP address will appear on the control screen as the console tab of the web
interface. The green popup will disappear after 10 seconds.

(B EIE] T0 ON :
Response O |

WIiFi module is connected to access point
IP address

Control ||  Print | Console

Figure 60: Sigma Control Screen WiFi Confirmation

Note: Sigma can also be powered down so the SD card storing the config.g file can be
removed from the controller. Within the system file of the SD card is the Config.g file.
This file can opened and modified with a program editor such as Notepad.
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6.4 Uploading G-code to Sigma

1. Connect to the Sigma network using the directions from Sigma Wireless Connection
Setup.

2. From the Sigma web interface, select Upload & Start.

3. Choose the desired G-code file. Once uploaded, Sigma will run the dispense path.

More detailed information regarding how to use the Web Interface and Control
Screen are provided in the next sections.

6.5 Web Interface Overview

6.51 Header Bar

The Header bar allows you to view machine status, connect and disconnect the machine,
quickly enter a G-code, upload a G-code to run, and stop the machine.

PvA E3 ASend | #Upload & Start | [RE S A ea o))
Machine Connect/ Quick G- Quick Upload Emergency
Status Disconnect code entry and Run Path Stop

Figure 61: Header Overview

6.5.2 Machine Control

Machine Control allows you to home the X, Y, and Z axis and jog individual axis. You can
also quickly run user-defined macros such as turning tools on and off, turning material
pressure on and off, and deselecting tools.

Jog X.Y,orZ
axis

Home X,Y,and Z
axis

Quick Access to
Macros

or Home All

A Machine Control Head Movement User-Defined Macros
¥4 Job Status Home X < x50 < x-10 < X1 < X-01 X+01 ¥ X1 > X+10 ¥ X+50 ¥ ToON
T0 OFF
Home ¥/ < Y50 < Y10 <yt < ¥o1 Y401 ¥ Y1y Y10 ¥ Y+50 ¥
> G-Code Console TO MAT PRESS ON
<zZ25 €zs € Zos < 7005 7+005 ¥ 7+05 ¥ 45 Z+25 % .
B Code Files TO MAT PRESS OFF
Deselect Tools
& Macros

Figure 62: Machine Control Overview
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6.5.3 Job Status

Job Status will display the progress of the current path. You can also change speed, pause
the job, or start another job when the path is complete.

Path Progress

Processed Practical Final_0001.gcode, 100% Complete

& Machine Control
sos Conto Laer Stastics speed Factr
s | Pause Job or Start -
Another Job when Change Speed ®

> G-Code Console
3 Start Anothar

& ¢ Code Files

complete

Enable Auto-Sleep
Extrusion Factors

& Macros
2 Baby Slepping 100 %
Extruder O
O Filaments Current Offset: 0 mm 056 P
100%
£ Settings &-006mm | 4005mm 2 i 5 8 1 2 1 . o 2 Exiruder 1 °

Figure 63: Job Status Overview

6.5.4 G-code Console

The G-Code Console provides a log of G-Codes entered, responses and errors, warnings,
and notifications received since the browser was last refreshed. The console output can be
downloaded as a plain text or CSV file.

6.5.5 G-code Files

G-Code Files allows for G-code files to be uploaded, downloaded, deleted and sorted into
sub directories.

Upload G-
Search G- code Files
codes
A Machine Cantrol L EOINIRe & G-Codes Directory [ -XeCIUI % Upload G-Code File(s)
¥4 Job Status File Name |2 size Last modified Object Height Layer Height Filament Usage Generated by
B APEX DISP LOOPgcode 7510KB | 1/22/2020, 7:44:04 AW nia va na na
> G-Code Console
B APEX DISP gcode 18KiB 1/23/2020, 11:54:26 AM nia n'a na na
A& Code Files < -
B LP 10x40x2 geode 249 KB 5/6/2020, 8:03:21 AM 9.4 mm 02/0.4mm 949.1.mm Cura_SteamEngine 4.5.0
& 05
&' Macros B Practical Final_0001 gcode 21.9KiB 5/18/2020, 3.15:27 PM n'a a na e
B Practical full test_0001.gcode 136 KiB 5/14/2020, 10:17:17 AM n'a na na na
@ Filaments
B Practical Path_ 35KiB 5/15/2020, 2:08:21 PM n'a a na na
£ Saltings
B Practical Patn 1020 B 5/15/2020, 2:48:21 PM na va na na
B Practical Path_0008.goode 6248 5/15/2020, 2:54:10 PM na na na na

Figure 64: G-code Files
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Files can be uploaded by browsing for them or dropping them onto the Upload G Code
Files(s) button. The file upload functionality cannot be used during while the machine is

running.

Upload Complete!

Filename Size Progress

« Practical FInal_0001.gcode 219 KB ‘ ! 3 b |

Figure 65: Upload G-Code File

Right-click on a G-code file to display a list of options. From here, you can run the dispense
part (Print File), estimate the dispense path time (Simulate File), or download the G-code
file (Download). You can also rename or delete the file, as well as manually edit the G-code.

P Frint File
» Simulate File

& Download

# Edit
1T Rename
X Delete

Figure 66: G-code Right Click Options
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Editing 0:/gcodes/Practical FInal_0001.gcode

;PVA Gecode Generator
;Version: 1.0.9
;Date: ©5/18/2020 Time: 15:15:55

M98 P"BEGIM.G" ;Begining of Program Macro
G21 ;All units in mm

;Layer: Dispense Board High comp

;Starting Path id: Dispensing Board High Comp_1
T®

Gee P@ 7 50.000008 F 3000.0

GOR PO X 217.127220 Y 139.04277@

GO1 PO Z 32.000000 F 3000.@ ;Penetrate

M3g8 P"TO_ON.G" ;Tool On
GB4 P109.9 ;Valve On Time ms

@ .

s

Figure 67: Edit G-Code

6.5.6 Macros

Macros allows you to upload and edit user-defined macros.

Search
Macros
A& Machine Control & Macros Directory = Go Up # Upload Macro File(s) m
51 Job Status O File Name 13 Size Last modified
o K 1_T0ON 148 1/20/2020, 110418 AM
>_ G-Code Console
o K 2_T0OFF 158 1/20/2020, 11:05:07 AM Upload Macro
& Code Files N File
© B 5 TOMATPRESS ON 108 1/20/2020, 11:05:08 AM
ol e |
SRS = © B 6_TOMAT PRESS OFF 108 112072020, 11:05:13 AM
© B Deselect Tools 3B 11/18/2019, 2:36:03 PM
O Filaments
£¥ Settings

Figure 68: Macros
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6.6 Control Screen Overview

The control screen on Sigma has the same features and functionality of the web interface.
The two can be used interchangeably.

F PVA
pSToP IR Il 13 ][T”

Current°C 00 o | TO OFF -]
Active°C | 0 | TO MAT PRESS ON |
Standoy°C | 0 | | TO MAT PRESS OFF

X900 Y100 27500 |@)

EeE.SE SlE 53,

_Control e | Print@ | Console &

Figure 69: Control Screen

Select Tools
Current Position

Home All, Home X, Home Y, Home Z

Access G-code Files

' BE | Files on card 0 [ > | e
E APEX DISP LOOPgcode
! APEX DISPgcode

\ drypath_0001.gcode

\ ~ LP 10x40x2.gcode

\ Practical Flnal_0001gcode

\ Practical full test 0001 gcode
|
|

Practical Path_0001.gcode
Practical Path_0006gcode

L] ]

!

K

Figure 70: Access G-code Files (Control)
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e Move Individual Axis

x (2008 10 1 B.0x " 01 1

v (200 -10 || 1 | 101][01 ] {1 Hlof 100
z [50 ][ 5 J[-05][-005][005][ 05 |[ 5 ][ 50

X800 Y100 77500

Control Print console

Figure 71: Move Axis (Control)

e Access Macro Files

; TO ON |
me TO OFF ]
| TO MAT PRESS ON |
| TO MAT PRESS OFF |
| |

Deselect Tools

Figure 72: Access Macro Files (Control)

o Control Screen (Current Screen)
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e Print Screen

E s8]

Current°C 00
Active°C | O
Standby°C| 0 |

Extruder % :
| Speed 100% || Fan 0% || Pause || Baby ¢

X900 Y100 Z10500

Setup

Figure 73: Print Screen

e G-code Console

@ Quick Access Macros
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7.Maintenance

Perform the preventative maintenance as shown in the table below to increase the life of
the workcell and make sure every run is high quality.

Note: Only qualified personnel should perform workcell maintenance.

Service Area

Every Shift

Weekly

Monthly

Quarterly

Dispense
Equipment

Examine all fluid
pressures and
dispense weights

Clean material
buildup on fixtures
and locating
surfaces.

Examine for leaks
around
compression
fittings, tighten or
replace if
necessary.

Ensure all sealing
packings are
lubricated. Refer to
individual
component
manuals for the
procedure.

Examine the fluid
delivery lines for
excessive wear.

Examine the inline
material filter for
clogs

Electro-
mechanical
components

Examine the
motors for
overheating and
smooth operation.

Examine wires,
pneumatic lines,
and material lines
for wear

Ensure all belts are
taught.

Examine all moving
cables for
excessive wear.

Lubricate all rails
with a lithium
based oil.

Pneumatics

Examine for
correct operation.

Drain any water
from the main
filter/regulator

Examine the slides
for wear and
smooth operation

Clean Purge Cups

Daily

Clean Valve Tips

Daily
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8.Technical Support
8.1 Calling Technical Support

Technical Support is always available to help. The phone number is +1 (844) 734-0209 or
you can email cs@pva.net to create a support ticket. Before you contact PVA, have the
following information:

1. Record all the information on the OIT when the error occurred, include any error
messages that may appear.

2. Record the operation in progress when the module had the error (when did it have
problems, what was it doing, etc.).

3. If the error was not serious, attempt to repeat the error. If the error does not repeat,
the problem may have been operator generated.

8.2 Support Portal

PVA uses an automated ticketing system called Team Support. The fastest way to contact
PVA for any technical support is to create a ticket. The ticketing system alerts the service
department of your region and assigns a service engineer. All service engineers can see
the information for each ticket for collaborate responses to more difficult problems from
our global team. Each problem and response can be tracked from creation to resolution.
The Support Portal also has information on common issues and possible solutions. If
immediate support is necessary, call your regional office (https://pva.net/contact).

1. To access the ticketing system, click Support Portal located at the bottom of
https://pva.net/ homepage.

ABOUT US v PRODUCTS v INDUSTRIES v LIBRARY v CONTACT US v

Figure 74: Support Portal
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2. Select “Log In" to log in to your account or create a new one.

PVA Support Hub Knowledge Base Tickets

Submit a Ticket Log In

4 & &

Tickets Knowledge Base Log In
Log in to track the status of your Find helpful documentation and Log in for additional content
existing support tickets. training guides and features.

Figure 75: Log In

3. The Sign In screen will be shown. Fill in the information and select Sign In.

4. Toregister, select Create an Account. Fill in the information and select Register
Me.

Name (First and Last)

Email (Username)

Password

i ' l Password Confirmation

Forgot my password

Create an account ‘

Figure 76: Sign In or Register

5. When you are signed in, select Submit a Ticket from the header.

Submit a Ticket

PVA Support Hub Knowledge Base Tickets Kimberly Fagan ~

Figure 77: Submit a Ticket
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6. Fillin the information requested and use as much detail as possible. Include the
equipment serial number and any screenshots, photos, or videos.

7. Once complete, select Submit Ticket.

Title (Subject)

Serial Number

Description

=
ey
=
=
4
>
4
1
fi
n
ii]
4

o

Drop files here or click to upload

Images can be pasted into the description as well

Figure 78: Complete the Ticket

8. If you cannot access the PVA Support Portal, email customer service at cs@PVA.net

to create a ticket. To reply to a ticket email, select Reply (not Reply All).

H © O »  Serial.. Eal |

Mess | Inser | Dpti<| Farm | Revie | Help | Adot| Q Tell me

[
Subject Serial # - Small description of problem

Detail content of your issue.
Add photos, videos or screen shots if possible.
Best Regards

PVA CUSTOMER

Figure 79: Example Ticket Email
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9. You can also access the PVA Support Hub from “PVA Support Hub” option in the
header or through the link https://support.pva.net/. The support hub has processes

and procedures on common topics and issues, including the Sigma manual.

PVA Support Hub Knowledge Base Tickets Search Submit a Ticket Kimberly Fagan ~

Figure 80: PVA Support Hub

PVA Support Hub

7% ’17
Q/Yf‘* )

Internal Training &
Installation & Setup Documents Process & Applications Programming & Software Technical Service

Figure 81: Support Hub Website
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10. Notes
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11. Warranty

PVA Warranty Policy

PVA warrants the enclosed product against defects in material or workmanship on all
components for one year from the date of shipment.

The warranty does not extend to components damaged due to misuse, negligence, or
installation and operation that are not in accordance with the recommended factory
instructions. Unauthorized repair or modification of the enclosed product, and/or the use of
spare parts not directly obtained from PVA (or from factory authorized dealers) will void all
warranties.

All PVA warranties extend only to the original purchaser. Third party warranty claims will not
be honored at any time.

Prior to returning a product for a warranty claim, a return authorization must be obtained
from PVA’'s Technical Support department. Authorization will be issued either via the
telephone, facsimile, or in writing upon your request.

To qualify as a valid warranty claim, the defective product must be returned to the factory
during the warranty period. Upon return, PVA will repair (or replace) all components found
to be defective in material or workmanship.

(Retain this for your records)

Product Information:

PRODUCT:

SERIAL NUMBER:

DATE OF PURCHASE:
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